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Notices
© Agilent Technologies, Inc. 2007

No part of this manual may be reproduced in 
any form or by any means (including elec-
tronic storage and retrieval or translation 
into a foreign language) without prior agree-
ment and written consent from Agilent 
Technologies, Inc. as governed by United 
States and international copyright laws.

Manual Part Number

82351-90701

Edition
First Edition, April 30, 2007

Printed in Malaysia

Agilent Technologies, Inc.
3501 Stevens Creek Blvd. 
Santa Clara, CA 95052 USA

Warranty

The material contained in this docu-
ment is provided “as is,” and is sub-
ject to being changed, without notice, 
in future editions. Further, to the max-
imum extent permitted by applicable 
law, Agilent disclaims all warranties, 
either express or implied, with regard 
to this manual and any information 
contained herein, including but not 
limited to the implied warranties of 
merchantability and fitness for a par-
ticular purpose. Agilent shall not be 
liable for errors or for incidental or 
consequential damages in connec-
tion with the furnishing, use, or per-
formance of this document or of any 
information contained herein. Should 
Agilent and the user have a separate 
written agreement with warranty 
terms covering the material in this 
document that conflict with these 
terms, the warranty terms in the sep-
arate agreement shall control.

Technology Licenses 
The hardware and/or software described in 
this document are furnished under a license 
and may be used or copied only in accor-
dance with the terms of such license.

Restricted Rights Legend

U.S. Government Restricted Rights.  Soft-
ware and technical data rights granted to 
the federal government include only those 
rights customarily provided to end user cus-
tomers.  Agilent provides this customary 
commercial license in Software and techni-
cal data pursuant to FAR 12.211 (Technical 
Data) and 12.212 (Computer Software) and, 
for the Department of Defense, DFARS 
252.227-7015 (Technical Data - Commercial 
Items) and DFARS 227.7202-3 (Rights in 
Commercial Computer Software or Com-
puter Software Documentation).

Safety Notices

CAUTION

A CAUTION notice denotes a haz-
ard. It calls attention to an operat-
ing procedure, practice, or the like 
that, if not correctly performed or 
adhered to, could result in damage 
to the product or loss of important 
data. Do not proceed beyond a 
CAUTION notice until the indicated 
conditions are fully understood and 
met. 

WARNING

A WARNING notice denotes a 
hazard. It calls attention to an 
operating procedure, practice, or 
the like that, if not correctly per-
formed or adhered to, could result 
in personal injury or death. Do not 
proceed beyond a WARNING 
notice until the indicated condi-
tions are fully understood and 
met.

Microsoft ® is a U.S. registered trademark 
of Microsoft Corporation.



Safety Symbols
The following symbols on the instrument and in the documentation 
indicate precautions which must be taken to maintain safe operation of 
the instrument.

Direct current

Alternating current

Both direct and alternating current

Three-phase alternating current

Earth (ground) terminal

Protective conductor terminal

Frame or chassis terminal

Equipotentiality

Off (supply)

On (supply)

Equipment protected throughout by double insulation or reinforced 
insulation.
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Caution, risk of electric shock.

Caution, risk of danger (refer to this manual for specific Warning or 
Caution information.

Caution, hot surface.

Out position of a bi-stable push control.

In position of a bi-stable push control.
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General Safety Information

The following general safety precautions must be observed during all 
phases of operation, service and repair of this instrument. Failure to 
comply with these precautions or with specific warnings elsewhere in this 
manual violates safety standards of design, manufacture and intended use 
of the instrument. Agilent Technologies assumes no liability for the 
customer’s failure to comply with these requirements.

WARNING • Do not use the device if it appears damaged or defective.
• Observe all markings on the device before connecting any wiring 

to the device.
• Do not operate the device in the presence of flammable gases or 

fumes.
• Do not install substitute parts or perform any unauthorized 

modification to the device.

CAUTION • Use the device with the cables provided.

• Repair or service that this not covered in this manual should only be 
performed by qualified personnels.
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Environment Conditions

This instrument is designed for indoor in the area with low condensation. 
Table 1 shows general environment requirements.

Table 1 Environment Requirements

Environment Conditions Requirements

Operating environment – 5 °C to 60 °C

Operating humidity Up to 90% at 40 °C non-condensing

Storage environment – 40 °C to 70 °C

Storage humidity Up to 90% at 65 °C non-condensing

CAUTION The Agilent 82351A PCIe GPIB Interface complies with the following 
safety and EMC requirements:

• IEC 61010-1:2001 / EN61010-1:2001

• Canada: CSA C22.2 No. 61010-1:2004

• IEC 61326:2002 / EN61326:1997+A1:1998+A2:2001+A3:2003 
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Regulatory Markings

The CE mark is a registered trademark of the European 
Community. This CE mark shows that the product complies 
with all the relevant European Legal Directives. 

ICES/NMB-001 indicates that this ISM device complies with 
Canadian ICES-001.

The CSA mark is a registered trademark of the Canadian 
Standards Association. A CSA mark indicates that the product 
is certified for Canadian markets, to the applicable Canadian 
standards.

The C-tick mark is a registered trademark of the Spectrum 
Management Agency of Australia. This signifies compliance 
with the Australia EMC Framework regulations under the 
terms of the Radio Communication Act of 1992.

This instrument complies with the WEEE Directive 
(2002/96/EC) marking requirement. This affixed product label 
indicates that you must not discard this electrical/electronic 
product in domestic household waste.
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Waste Electrical and Electronic Equipment (WEEE) Directive 
2002/96/EC

This instrument complies with the WEEE Directive (2002/96/EC) marking 
requirement. This affixed product label indicates that you must not discard 
this electrical/electronic product in domestic household waste. 

Product Category:

With reference to the equipment types in the WEEE directive Annex 1, this 
instrument is classified as a “Monitoring and Control Instrument” product.

The affixed product label is shown as below:

Do not dispose in domestic household waste

To return this unwanted instrument, contact your nearest Agilent office, or 
visit: 

www.agilent.com/environment/product

for more information.
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DECLARATION OF CONFORMITY 
According to EN ISO/IEC 17050-1:2004

Generic example 
Manufacturer’s Name: Agilent Technologies Microwave Products (M) Sdn. Bhd 
Manufacturer’s Address: Bayan Lepas Free Industrial Zone, 

11900, Bayan Lepas, Penang, Malaysia 

Declares under sole responsibility that the product as originally delivered 

Product Name: Agilent PCIe-GPIB Interface Card 
Models Number: 82351A 
Product Options: This declaration covers all options of the above product(s) 

complies with the essential requirements of the following applicable European Directives, and 
carries the CE marking accordingly: 

Low Voltage Directive (2006/95/EC)
EMC Directive (89/336/EEC, amended by 93/68/EEC) 

and conforms with the following product standards: 

EMC StandStandStandStandardardardard    LimitLimitLimitLimit    

IEC 61326:2002 / EN 61326:1997+A1:1998+A2:2001+A3:2003 
CISPR 11:1990 / EN55011:1990 Class A Group 1 
IEC 61000-4-2:1995 / EN 61000-4-2:1995 4 kV CD, 8 kV AD 
IEC 61000-4-3:1995 / EN 61000-4-3:1996 3 V/m, 80-1000 MHz 
IEC 61000-4-4:1995 / EN 61000-4-4:1995 0.5 kV signal lines, 1 kV power lines 
IEC 61000-4-5:1995 / EN 61000-4-5:1995 0.5 kV line-line, 1 kV line-ground 
IEC 61000-4-6:1996 / EN 61000-4-6:1996 3 V, 0.15-80 MHz  
IEC 61000-4-11:1994 / EN 61000-4-11:1994 1 cycle / 100% 

Canada: ICES-001:2004 
Australia/New Zealand: AS/NZS CISPR11:2004   

The product was tested in a typical configuration with Agilent Technologies test systems. 

Safety IEC 61010-1:2001 / EN 61010-1:2001 
Canada: CAN/CSA-C22.2 No. 61010-1-04 

This DoC applies to above-listed products placed on the EU market after:  

20-April-2007 
Date    Mack Soh 

   Quality Manager 

For further information, please contact your local Agilent Technologies sales office, agent or distributor, 
or Agilent Technologies Deutschland GmbH, Herrenberger Straße 130,  71034 Böblingen, Germany. 

Template: A5971-5302-2, Rev. D.00 82351A DoC Revision 1.0 
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Product Regulations  

                  
Performance Criteria 

IEC 61326-1:2002 / EN 61326-1:1997+A1:1998+A2:2001+A3:2003

CISPR 11:1990 / EN 55011:1990 – Group 1 Class A  
IEC 61000-4-2:1995 / EN 61000-4-2:1995 (ESD 4kV CD, 8kV AD) A 
IEC 61000-4-3:1995 / EN 61000-4-3:1996 (3V/m, 80% AM) A 
IEC 61000-4-4:1995 / EN 61000-4-4:1995 (EFT 0.5kV line-line, 1kV line-earth) A 
IEC 61000-4-5:1995 / EN 61000-4-5:1995 (Surge 0.5kV line-line, 1kV line-earth) A 
IEC 61000-4-6:1996 / EN 61000-4-6:1996 (3V, 0.15~80 MHz, 80% AM, power line) A 
IEC 61000-4-11:1994 / EN 61000-4-11:1994 (Dips 1 cycle, 100%) A 
Canada: ICES-001:2004 
Australia/New Zealand: AS/NZS CISPR11:2004 

EMC 

IEC 61010-1:2001 / EN 61010-1:2001 
  Canada: CAN/CSA-C22.2 No. 61010-1-04 

Safety 

Additional Information: 
The product herewith complies with the essential requirements of the Low Voltage Directive 2006/95/EC and the 
EMC Directive 89/336/EEC (including 93/68/EEC) and carries the CE Marking accordingly (European Union).

1Performance Criteria: 
A Pass - Normal operation, no effect. 
B Pass - Temporary degradation, self recoverable. 
C Pass - Temporary degradation, operator intervention required. 
D Fail - Not recoverable, component damage. 
N/A – Not applicable 

Notes: 

Regulatory Information for Canada
ICES/NMB-001:2004 
This ISM device complies with Canadian ICES-001. 
Cet appareil ISM est confomre à la norme NMB-001 du Canada. 

Regulatory Information for Australia/New Zealand
This ISM device complies with Australian/New Zealand AS/NZS CISPR11:2004 
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In This Guide…
This guide provides step- by- step setup and configuration 
instructions that get you familiarized with the operations of 
the Agilent 82351A interface. This guide also contains 
troubleshooting guidelines that helps to resolve your 
problems during installations and configurations.

1 Installing and Configuring the 82351

Chapter 1 provides detailed steps to install and configure 
the Agilent 82351A PCIe GPIB interface, and guidelines to 
begin programming via the 82351A interface. 

2 Troubleshooting Guidelines

Chapter 2 contains hardware and software verification steps 
to troubleshoot the connectivity and functionality of the 
Agilent 82351A PCIe GPIB interface. 

3 Specifications and Characteristics

Chapter 3 lists specifications and characteristics of the 
Agilent 82351A PCIe GPIB interface.

4 General Information

Chapter 4 contains general information for the Agilent 
82351A PCIe GPIB, including warranty information, related 
documentation and Agilent contacts.
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Installing and Configuring the 82351

Getting Started       6

Step 1 – Before You Install the 82351       8

Step 2 – Installing Agilent IO Libraries Suite       10

Step 3 – Installing 82351 Driver       12

Step 4 – Connecting Your Instruments       13

Step 5 – Configuring the 82351       20

Step 6 – Communicating with Instruments       24

This Agilent 82351A PCIe GPIB Interface User’s Guide guides you the 
steps to install and configure the Agilent 82351A PCIe GPIB interface 
(called the 82351 in this guide) and shows you how to configure the 82351 
PCIe GPIB interface card using Agilent IO Libraries Suite in Windows 
2000 or Windows XP operating systems.

NOTE In case of difficulty in installing the 82351, see Chapter 2   Troubleshooting Guidelines. 
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1 Installing and Configuring the 82351
Getting Started

In this guide, an 82351 GPIB Interface System is defined as a system in 
which GPIB instruments are connected via GPIB cables to an 82351 PCIe 
GPIB interface card (called the 82351 in this guide) that is installed in a 
Windows PC. The Figure 1- 1 shows a typical system.

Figure 1-1 Typical configuration system

The Figure 1- 2 shows a suggested sequence of steps to install and 
configure 82351 and to communicate between your PC and GPIB 
instruments via 82351.

To get started, you may use the Figure 1- 1 as a guide as you set up your 
GPIB system. See the associated step if you need more details. See 
Chapter 2   Troubleshooting Guidelines if you need additional information 
on setting up the 82351 or GPIB instruments.

GPIB Cable

Instrument Instrument
PC

Connect to 82351 GPIB
interface card installed in PC.

Connect to GPIB
port on instrument.
6 Agilent 82351 PCIe GPIB Interface 



Installing and Configuring the 82351 1

 

Figure 1-2 Steps to install and configure the 82351 Interface

Step 1 — Before You Install the 82351
✔ Checking your shipment
✔ Checking system requirements

Step 2 — Installing Agilent IO Libraries Suite
✔ Checking for installed libraries
✔ Installing the IO Libraries Suite

Step 3 — Installing 82351 driver
✔ Installing driver

Step 4 — Connecting Your Instruments
✔ Installing the 82351 in your PC
✔ Connecting instruments to the 82351

Step 5 — Configuring the 82351
✔ Installing configuration files
✔ Configuring the 82351 interface

Step 6 — Communicating with Instruments
✔ Verifying instrument communication
✔ Programming your instruments (optional)
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1 Installing and Configuring the 82351
Step 1 – Before You Install the 82351

Before you install the 82351, you should:

✔ Check Your Shipment

✔ Check System Requirements

✔ Create an Emergency Repair Disk

Checking Your Shipment

Your 82351 interface shipment should include the items in the following 
figure. If any items are missing or damaged, keep the shipping materials 
and contact Agilent Technologies. See Chapter 4   General Information for 
addresses and telephone numbers. 

CAUTION To reduce the risk of damaging the 82351 card, protect the card from static electricity. 
Leave the card in its anti-static bag until you are ready to install the card. Handle the 
card ONLY by the sheet metal frame or by the card edges. Never touch any other part of 
the card.

82351A PCIe GPIB Interface Card

Agilent Automation-Ready CD
and

82351A Product 
Reference CD 82351A Quick

Start Guide

✔ Agilent 82351A PCIe GPIB Interface Card
✔ Agilent Automation-Ready CD with IO Libraries Suite
✔ Agilent 82351A Product Reference CD
✔ Agilent 82351A Quick Start Guide
8 Agilent 82351 PCIe GPIB Interface 



Installing and Configuring the 82351 1
Checking System Requirements

Before you install the Agilent IO Libraries Suite, you should verify that 
your system meets the minimum hardware and software requirements 
listed to install and use the Agilent IO Libraries Suite. Adding additional 
RAM may improve overall system performance. 

Table 1-1 System requirement for installing 82351 interface card

Creating an Emergency Repair Disk

The Agilent IO Libraries Suite includes I/O drivers for various PCIe 
plug- in cards. Extensive testing of these drivers and cards has revealed 
that early revisions of the BIOS code in several PCs are not completely 
PCIe- compliant. This has caused problems when running the Agilent IO 
Libraries, whether or not the PCIe card is installed. Problems can include 
system errors, operating system crashes, or card initialization failures.

Item Minimum Requirements

Hardware Requirements

PC Operation/Memory Pentium® IV (with PCIe slot supported)

128 MB RAM (256 MB or greater is recommended)

Hard Drive Space 225 MB for installation:

• 160 MB for Microsoft .NET Framework, 
• 65 MB for Agilent IO Libraries Suite

175 MB for operation:

• 110 MB for Microsoft .NET Framework,
• 65 MB for Agilent IO Libraries Suite

PCIe Bus Slot At least one 3.3 V PCIe Bus Slot (to install 82351). 
82351 is a 3.3 V card and can be fit in PCIe 1x, PCIe 4x or PCIe 8x slot.

Software Requirements

Operating System Windows 2000/XP
Agilent 82351 PCIe GPIB Interface 9



1 Installing and Configuring the 82351
Step 2 – Installing Agilent IO Libraries Suite

This step shows how to install the Agilent IO Libraries Suite software, 
using default settings, including:

✔ Checking for Agilent IO Libraries Suite

✔ Installing Agilent IO Libraries Suite 

Checking for Installed Agilent IO Libraries

Before you begin installation, check for previously installed Agilent IO 
Libraries software. If a version of the Agilent IO Libraries or Agilent IO 
Libraries Suite is installed on your PC, an IO icon may be displayed on 
the Windows task bar (on the lower right- hand side of the screen as 
shown in Figure 1- 3).

Figure 1-3 IO Libraries Suite icon

• If either IO icon is displayed, click the icon and click About Agilent IO 
Control to display the version. The version must be 14.2.8931.1 or 
greater. 

• If the IO icon is not displayed, a version may still be installed. To check 
this, click Start > Programs and look for the Agilent IO Libraries or 
Agilent IO Libraries Suite program group. 

NOTE • See the Agilent IO Libraries Getting Started Guide on your Automation-Ready CD for a 
full description of installation options and installation troubleshooting information.

• You must have Administrator privileges to install the IO Libraries Suite and to run the 
Connection Expert utility.

IO Libraries Suite icon
10 Agilent 82351 PCIe GPIB Interface 



Installing and Configuring the 82351 1
• If this group is displayed, click Agilent IO Libraries Suite > Utilities > 
IO Control to display the IO icon. Then, click the icon and click About 
Agilent IO Control to display the installed version (must be 14.2.8931.1 
or greater). 

• If neither the IO icon nor the Agilent IO Libraries program group is 
displayed, it means no Agilent IO Libraries are installed yet. You can 
use the steps in this chapter or in the Agilent IO Libraries Suite 
Getting Started Guide to install the libraries. 

• If the version of the Agilent IO Libraries is less than 14.2.8931.1, you 
must install the newer version included on your Automation- Ready CD 
to support the 82351A.

• If your version of the Agilent IO Libraries is above 14.2.8931.1, but less 
than the version on your Automation- Ready CD, you may want to 
install the newer version to take advantage of new features and greater 
ease of use of the more recent Agilent IO Libraries Suite. 

Installing Agilent IO Libraries Suite

To install the Agilent IO Libraries Suite software,

1 First, disconnect any USB instruments, USB/GPIB converters, and 
FireWire- VXI interfaces that are connected to your PC.

2 Insert the Automation- Ready CD in your CD- ROM drive. Wait a few 
seconds until the Agilent IO Libraries Suite auto- run window appears.

3 If the auto- run window does not appear automatically, click Start > 
Run... and type <drive>:autorun\auto.exe, where <drive> is your 
CD drive letter.

4 When the Agilent IO Libraries Suite auto- run window appears, follow 
the directions in this window to install the Agilent IO Libraries Suite. 
See the Agilent IO Libraries Getting Started Guide on your 
Automation- Ready CD for a full description of installation options and 
installation troubleshooting information.

NOTE Agilent IO Libraries Suite 14.0 is the revision immediately following Agilent IO Libraries 
M.01.01, so you should consider revision “14.0” to be a greater version number than “L” or 
“M”. Configuration instructions in this manual make use of Agilent IO Libraries Suite 14.2.
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1 Installing and Configuring the 82351
Step 3 – Installing 82351 Driver

After the Agilent IO Libraries Suite (version 14.2.8931.1 or greater) has 
been installed, insert the Agilent 82351A Product Reference CD for 
installation.

1 Insert the Agilent 82351A Product Reference CD into your CD- ROM 
drive. Wait for a few seconds until the auto- run window appears. 

2 If the installer is not automatically activated, click Start > Run and 
type <drive>:autorun\auto.exe,where <drive> is your CD drive 
letter.

3 When the auto- run window appears, follow the instruction on that 
window to install the 82351A driver.
12 Agilent 82351 PCIe GPIB Interface 



Installing and Configuring the 82351 1
Step 4 – Connecting Your Instruments

This step shows how to install an 82351 in a PCIe slot in your PC and 
how to connect GPIB instruments to the 82351, including:

✔ Installing the 82351 in Your PC
✔ Connecting Instruments to the 82351 

Installing the 82351 in Your PC

1 Record the card serial number. Remove the card from its anti- static 
bag and record the serial number for future reference. Save the 
anti- static bag so you can protect the card if you need to remove the 
card from the PC.

The 82351 serial number is located on the white serial number label on 
the card. The serial number contains 10 characters that encodes the 
country of manufacture, Agilent year, workweek of manufacture and a 
unique sequential number. The last four digits indicate a unique serial 
number assigned sequentially to a 82351. 

2 Remove PC cover. Remove power from the PC and from all of its 
peripherals. Then, remove the power cord from the PC. Unlock and 
remove the cover from the PC to allow access to the I/O slots. See your 
PC documentation for instructions.

NOTE If you have not yet installed the Agilent IO Libraries Suite and 82351 driver, go to Step 2 – 
Installing Agilent IO Libraries Suite and install the software BEFORE you install the 82351 in 
your PC. To install 82351 driver, go to Step 3 – Installing 82351 Driver.

CAUTION To reduce the risk of damaging the 82351, only handle the card by the sheet metal 
frame or by its edges. Never touch any other part of the card, including the PCIe 
connector.

NOTE The 82351A is a 3.3 V PCIe card and will only fit in a PCIe 1x, PCIe 4x or PCIe 8x slot.
Agilent 82351 PCIe GPIB Interface 13



1 Installing and Configuring the 82351
Figure 1-4 Remove PC cover

3 Remove a cover plate. Remove one of the PC back panel cover plates. 
The 82351A is a 3.3 V PCIe card and will only fit in a PCIe 1x, PCIe 4x 
or PCIe 8x slot. Choose a 3.3 V PCIe slot that will give adequate 
clearance for the GPIB connector. 

Figure 1-5 Remove cover plate

NOTE Take precautions against static discharge when handling and installing cards.
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Installing and Configuring the 82351 1
4 Install the 82351. Insert the 82351 interface card edge connector into 
the PCIe expansion slot connector of the PC. Make sure the interface is 
fully seated by pushing firmly on the top edge of the card with the 
palm of your hand. The GPIB connector should extend through the back 
panel opening to allow GPIB cable connection. 

If you install more than one 82351, you may want to install the cards 
so there is at least one empty slot between every two 82351s. When 
inserting the 82351, be sure to hold the card by its edges. Also, be 
careful with the metal faceplate around the GPIB connector as the 
faceplate can be bent. 

Figure 1-6 Install 82351 interface card
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1 Installing and Configuring the 82351
5 Replace the cover plate screw. This will hold the 82351 in place. Save 
the blank cover plate for use if the 82351 is later removed. Replace the 
PC cover(s) as described in your PC documentation.

Figure 1-7 Replace the cover plate screw

Connecting Instruments to the 82351

After the 82351 is installed in your PC, the next step is to connect your 
GPIB instruments to the installed 82351. See the following suggested steps 
for the connection. When you have made the connections, go to Step 5 – 
Configuring the 82351.
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Installing and Configuring the 82351 1
1 Review connection guidelines. The recommended method for 
connecting a GPIB system is a linear arrangement with the system 
controller (PC) at one end of the system. However, a GPIB system can 
also be connected together in a star, linear, or a combination 
configuration as long as the total number of devices on the system is ≤ 
14. See the following guidelines:

• To minimize stress on connector mountings, no more than three 
cable connectors blocks should be stacked on top of one another. The 
GPIB connector screws should be finger- tightened only. 

• Minimize cable length as much as possible. All system devices must 
have tri- state drivers and must be powered on. For systems with 
devices that not using tri- state drivers, the transfer rate is limited to 
< 250 kilobytes/sec. Turning devices on or off while a system is 
running may cause faulty operation.

• For operation with data transfer rates < 500 kilobytes/sec, the total 
length of all GPIB cables is ≤ 2 meters times the number of devices 
connected together, up to a maximum of 20 meters. 

• For operation with data transfer rates > 500 Kbytes/sec, the total 
length of all GPIB cables is ≤ 1 meter times the number of devices 
connected together, up to a maximum of 15 meters. 

• The length between adjacent devices is not critical as long as the 
overall restriction is met. GPIB bus extenders are available that allow 
operation over much greater distances.

2 Connect GPIB Cables to the 82351. Connect a separate GPIB cable to 
each installed 82351. Tighten the GPIB connector screws finger- tight 
only. (The screwdriver slots are mainly for removal purposes only.) Two 
example connections follow connect a single GPIB instrument or to 
connect multiple GPIB instruments.

For information or to purchase Agilent GPIB cables, see 
www.agilent.com/find/gpibcables
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1 Installing and Configuring the 82351
Example: Connecting a single GPIB instrument

This Figure 1- 8 shows connections from a single GPIB instrument to the 
GPIB connector of an 82351 installed in your PC. You may want to record 
the primary GPIB address of the attached instrument for future 
programming use. After making the connections, reconnect the PC power 
cord and apply power to the PC and to attached peripherals or 
instruments.   

Figure 1-8 Connection from a single GPIB instrument to an 82351 GPIB interface card

CAUTION To avoid damage to the connectors, only finger-tighten the connectors.

GPIB Cable

InstrumentPC

GPIB Connector. Connect to GPIB
connector on 82351 GPIB interface
card installed in PC.

GPIB Connector. Connect to 
GPIB port on GPIB instrument. 
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Installing and Configuring the 82351 1
Example: Connecting multiple GPIB Instruments

This Figure 1- 9 shows one way to connect three GPIB instruments to an 
82351. You may want to record the primary GPIB address of each 
attached instrument for future programming use. After making the 
connections, reconnect the PC power cord and apply power to the PC and 
attached peripherals or instruments.

Figure 1-9 Connection from multiple GPIB instruments to 82351 GPIB interface card

NOTE Although the Figure 1-9 shows cable connections to GPIB Instrument 1, the connection can 
be to any GPIB instrument in the system. 

PC Instrument 1

Instrument 2

Instrument 3

GPIB Cable

GPIB Connector.
Connect to GPIB port
on GPIB instrument 1

GPIB Connector. Connect to GPIB 
connector on 82351 interface card.
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1 Installing and Configuring the 82351
Step 5 – Configuring the 82351

This step shows how to configure a Windows 2000/XP operating system in 
a PC that has an 82351 installed, including:

✔ Installing Configuration Files

✔ Configuring the 82351 Interface

Installing Configuration Files

1 Turn the PC ON. As Windows restarts, the system will detect the new 
hardware and Found New Hardware Wizard will appear. This Figure 
1- 10 shows a typical Windows 2000 display. The display may be 
different for other operating systems.

Figure 1-10 Found New Hardware Wizard window
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2 Install Configuration Files. Click Next > to accept the default 
suggestions. Click Finish to complete the installation. Then, go to 
Configuring the 82351 Interface.

Configuring the 82351 Interface

1 Open Connection Expert. Click the IO icon on the Windows taskbar, 
the Agilent Connection Expert window will appear as shown in Figure 
1- 11. Highlight the GPIB interface in the explorer view (tree view at the 
center of the window) and click Change Properties... to display the 
Agilent 82351 PCIe GPIB Interface dialog box as shown in Figure 1- 12.

Figure 1-11 Agilent Connection Expert window

NOTE For a description of Connection Expert and the Agilent IO Libraries Suite, see the Agilent IO 
Libraries Suite Online Help. To access this Help file, click the IO Control and select 
Documentation > IO Libraries Suite Help.

Change Properties 
button
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1 Installing and Configuring the 82351
2 Configure GPIB Card Parameters. When the Agilent 82351 PCIe GPIB 
Interface dialog box (Figure 1- 12) appears, set the VISA interface ID, 
SICL interface ID, Logical unit and GPIB address values as required. 

Also, verify that this is the System controller for the GPIB to which it 
is attached (this is the typical operating mode). Then, click OK. See 
Table 1- 2 for description of each settings and guidelines to set these 
values.

Figure 1-12 Agilent 82351 PCIe GPIB Interface dialog box

NOTE Changes to certain properties of the 82351, including:

• GPIB address
• System controller flag
• SICL interface ID
• Logical unit

will not take effect until you reboot your PC. If you choose not to reboot immediately, 
Connection Expert will display a warning icon  until you reboot.
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Table 1-2 82351 GPIB interface card configuration parameters

3 Repeat steps for other cards. If you have installed more than one 
82351 in your PC, repeat these steps for the remaining cards. Then, go 
to Step 6 – Communicating with Instruments.

82351 GPIB Interface Card Configuration Parameters

VISA Interface ID Symbolic name that VISA uses to uniquely identify this GPIB interface. The default VISA interface 
ID is GPIB0. The 82351 interface ID for VISA must begin with the string GPIB and have an integer 
appended to it, such as GPIB0, GPIB1, GPIB2, etc. Remember this value to properly address GPIB 
devices in your VISA applications.

GPIB Address Address of this GPIB interface controller on the GPIB bus. It is usually 21 if the GPIB interface is a 
System Controller or 20 if the GPIB interface is a non-System Controller (see System Controller, 
following). These addresses are chosen by convention but any address in the range 0 - 30, 
inclusive, may be used.

System Controller Determines if this interface controls which bus devices talk and which bus devices listen. If 
several devices exist on a bus, be sure each has a unique GPIB bus address and only one device is 
the System Controller. Each GPIB interface has its own independent bus. Thus, each interface may 
be a System Controller as long as it is not chained together with other GPIB interfaces. However, 
two or more System Controllers on the same bus will cause the bus to be inoperative.

SICL Interface ID Symbolic name that SICL uses to uniquely identify this GPIB interface. The default Interface ID is 
gpib0. The SICL interface ID must be a unique string of alphanumeric characters, starting with a 
letter. Remember this value and the logical unit number to properly address GPIB devices in your 
SICL applications.

Logical Unit Number that SICL uses to uniquely identify this 82351 interface. The logical unit number is an 
integer in the range of 0 - 10000. Remember this value and the SICL interface ID to properly 
address the GPIB interface in your SICL applications.
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Step 6 – Communicating with Instruments

After the 82351 has been configured and you have connected your GPIB 
instruments to the 82351, the next step is to establish communication 
between your PC and the instruments using the Interactive IO utility. 
After communication has been established, you can begin to program the 
instruments using VISA, VISA COM, SICL, or SCPI commands. This section 
includes:

✔ Verifying Instrument Communication

✔ Programming Your Instruments (Optional)

Verifying Instrument Communication 

When the Agilent IO Libraries Suite is installed on your PC, an I/O utility 
called Interactive IO is also installed. You can use Interactive IO to verify 
communication between your PC and the connected GPIB instruments. 
This section shows you how to verify instrument communication using 
Interactive IO. 

To use Interactive IO to send a *IDN? (identification) query to an 
instrument, see the steps below:

1 Select the instrument by clicking its icon in the Connection Expert 
explorer view.

2 Right- click the instrument and click Send Commands To This 
Instrument to display the Interactive IO window as shown in Figure 
1- 13. For information of the Interactive IO, including a list of common 
commands and the commands’ description, click Help > Help Topics.

NOTE Once your GPIB interface has been configured in Connection Expert, if you can see the 
attached GPIB instrument(s) in the Connection Expert explorer and the respective IDN 
string information in the detail pane, it means the communication has been established. 
Interactive IO allows you to manually verify communication and send specific commands to 
your instruments.
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3 *IDN? is the default command. Click Send & Read to send the 
identification query to the instrument and display its reply in the 
Interactive IO window. 

4 To send other commands, click Commands> to select from a list of 
common commands, or type a command into the Command: field. If 
you experience time- out errors for some commands, click Options to 
change the time- out value.

Figure 1-13 Agilent Interactive IO window
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Programming Your Instruments

This section provides an introduction to programming GPIB instruments 
via the 82351 PCIe GPIB interface using the Agilent VISA and SICL IO 
Libraries. You can program in various languages and applications, 
including Visual Basic, Visual C++, and Agilent VEE. 

See the applicable user’s guide, such as the Visual Basic user’s guide, for 
programming guidelines. You can also find additional programming 
examples using various IO Libraries and instrument drivers in the 
instrument user’s guide. After the 82351 is successfully installed and 
configured, it should act as a transparent interface for programming GPIB 
instruments.

For information on programming using Agilent VISA, see the Agilent VISA 
User’s Guide. For information on VISA COM and for function references 
for VISA, VISA COM, and SICL, see the IO Libraries Suite Online Help.

Accessing Programming Manuals and Help

You can access .pdf copies of the Agilent VISA User’s Guide and the 
Agilent SICL User’s Guide for Windows from the IO icon located on the 
Windows task bar. Adobe Acrobat Reader is required to view these 
manuals.

To access the Agilent VISA User’s Guide, click the IO icon and then click 
Documentation > VISA Users Guide. To access the Agilent SICL User’s 
Guide for Windows, click the IO icon and then click Documentation > 
SICL Users Guide. To access VISA COM information, and function 
references for VISA, VISA COM, and SICL, click the IO icon and then click 
Documentation > IO Libraries Suite Help. 
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Example: GPIB Interface Configuration

An I/O interface consists of a hardware interface and a software interface. 
One purpose of the Connection Expert utility is to associate a unique 
software interface ID with a hardware interface. The Agilent IO Libraries 
Suite uses an interface ID or logical unit number to identify an interface. 
This information is passed in the parameter string of the viOpen function 
call in a VISA program or in the iopen function call in a SICL program. 

For example, the GPIB interface system in the Figure 1- 14 consists of a 
Windows PC with two 82351 GPIB cards connected to three GPIB 
instruments via GPIB cables. For this system, the Connection Expert 
utility has been used to assign GPIB card #1 a VISA interface ID of 
“GPIB0” and a SICL interface ID of “gpib0”. 

Connection Expert has also been used to assign GPIB card #2 a VISA 
interface ID of “GPIB1” and a SICL interface ID of “gpib1”. With these 
names assigned to the interfaces, the VISA/SICL addressing is as shown in 
the Figure 1- 14. Since unique names have been assigned by Connection 
Expert, you can use the VISA viOpen command to open the I/O paths to 
the GPIB instruments. Or, you can use the SICL iopen command to open 
the I/O paths shown. 
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Figure 1-14 Example of GPIB interface configuration

GPIB Interface (82351 PCIe GPIB Cards)

82351 GPIB Card #1

82351 GPIB Card #2

5

3

3

Interface VISA/SICL IDs Window PC GPIB Cable GPIB Instruments

VISA Interface ID SICL Interface ID

“GPIB0” “gpib0”

“GPIB1” “gpib0”

VISA/SICL Addressing

VISA:   viOpen (...”GPIB0::5::INSTR”...)          Open IO path to GPIB instrument at address 5 using 82351 card #1
            viOpen (...”GPIB0::3::INSTR”...)          Open IO path to GPIB instrument at address 3 using 82351 card #1
            viOpen (...”GPIB1::3::INSTR”...)          Open IO path to GPIB instrument at address 3 using 82351 card #2

SICL:     iopen (“gpib7,5”)                               Open IO path to GPIB instrument at address 5 using 82351 card #1
                           iopen (“gpib7,3”)                               Open IO path to GPIB instrument at address 3 using 82351 card # 1
              iopen (“gpib8,3”)                               Open IO path to GPIB instrument at address 3 using 82351 card #2
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This chapter shows suggested troubleshooting steps when you encounter 
communication failure during 82351 installation.

NOTE Additional troubleshooting information appears in the Agilent IO Libraries Suite Online Help 
and on the Web at http://www.agilent.com/find/iolib
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2 Troubleshooting Guidelines
Troubleshooting Overview

A suggested troubleshooting flow chart for the 82351, installed 
instruments, and the Agilent IO Libraries Suite follows. We suggest you 
start at Step 1 and then go to Step 2 and then to Step 3, as required.

Figure 2-1 Troubleshooting flow chart

1   82351 Hardware Checks

Typical Causes
• Bad GPIB cables/

• Power not ON for PC or 
   instrument.

Typical Causes

• GPIB card drivers not installed.
• GPIB card not properly 

configured.

Typical Causes
• Agilent IO Libraries Suite not
   installed. 
• Improper IO Libraries Suite
  configuration.

Check cables/ 
connections/power.

Check for GPIB 
driver files

Check IO Libraries Suite
installation

Check Device Manager Disable Connection Expert
Auto-Discovery

Check IO Control 
Operation

Other hardware checks Check BIOS/Interrupts
settings

Install Libraries (if GPIB
already installed)

Set 82351 Read/Write
performance mode

After performing these checks:
• If the cause is not identified, see 
  Agilent IO Libraries Checks.

• If the cause is identified, but the 
  problem cannot be fixed, contact
  Agilent for support.

After performing these checks:

• If the causes is not identified,
  see 82351 Software Checks.

• If the cause is identified as an 
  82351 hardware problem, 
  contact Agilent to return the 
 82351.

After performing these checks:
• If the cause is not identified or
  the problem cannot be fixed, 
 contact Agilent for support.

  connections.

2   82351 Software Checks 3    IO Libraries Checks
30 Agilent 82351 PCIe GPIB Interface 



Troubleshooting Guidelines 2

 

82351 Hardware Checks

This section provides you guidelines to make hardware troubleshooting 
checks for the 82351, including:

✔ Check Cables, Connections and Power

✔ Check Device Manager

✔ If Sound Card Does Not Work

✔ If Data Transfers to Devices Fail

✔ If Connection Expert Finds 82351 Card with Serial Number ffffffff

Check Cables/Connections/Power

We suggest you to start troubleshooting sequence by performing hardware 
checks. If the hardware checks do not solve the problem, see 82351 
Software Checks.

1 Check GPIB cable connections. Check all GPIB cables for good 
connection to the GPIB connector on the 82351 installed in your PC 
and the GPIB cable connections between all connected GPIB 
instruments. An improperly attached GPIB connector can cause the bus 
to malfunction.

2 Check GPIB cables for damage. Check all GPIB cables for cuts/damage 
and check for bent/misaligned/crushed connector pins. Replace cables 
as required.

3 Disconnect/Reconnect GPIB cables. If Steps 1 and 2 do not solve the 
problem, try disconnecting and reconnecting (or replacing) GPIB cables. 

NOTE There are no user-serviceable parts for the 82351. If you suspect a hardware failure for the 
82351, contact Agilent for instructions to return the unit. 
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4 Check PC/instrument power- on. Verify that the PC and all connected 
GPIB instruments are functional and are powered ON. Verify that host 
computer is not in a suspended power management state.

5 Reboot your PC. If doing steps 1, 2, 3 or 4 does not solve the problem, 
reboot the PC. If this does not solve the problem, go to Check Device 
Manager.

Check Device Manager

You can use the Windows Device Manager to re- install the 82351 or 
equivalent, as required. For example, with Windows 2000, go to Control 
Panel by selecting Start > Settings > Control Panel.

Then, select System > Hardware > Device Manager. From Device 
Manager, select 82351 and then Properties. Tab to Driver and click 
Reinstall Driver. 

This will allow the Windows Plug and Play Manager to begin searching 
for a driver for the 82351. Since Device Manager may have disabled the 
82351 device, click Enable to restart the 82351. If this does not resolve 
the problem, go to 82351 Software Checks.

If Sound Card Does Not Work

If your sound card stops working after configuring interfaces, disable the 
auto- discovery process in Connection Expert. The auto- discovery process 
can cause sound and other cards to stop responding. To disable the 
auto- discovery process, run Connection Expert, select Tools > Options, 
and clear the check boxes labeled Automatic discovery or refresh of I/O 
resources and Automatic configuration of unconfigured interfaces. Close 
Connection Expert and restart your PC.
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If Connection Expert Finds 82351 Card with Serial Number 
ffffffff

If Connection Expert reports finding an 82351 card with serial number 
ffffffff, this is typically caused by getting into a situation where PCIe 
cards are not properly configuring. Try the following: 

1 Upgrade your system BIOS to the latest version. Note that new 
computers often have newer BIOSs available. When installing new BIOS, 
ensure the BIOS Installed O/S setting is set correctly. This determines 
what software will configure all the Plug and Play cards in your system. 
Either the BIOS or the operating system can perform the task of 
querying all the cards to determine their resource needs, picking a valid 
configuration for all these cards, and telling the cards what their actual 
resource settings are.

2 If your computer locks up or freezes after installing. Typically, this is 
caused by interrupt conflicts with other drivers in the system. PCIe 
allows sharing of IRQs, but this also means that the drivers for cards 
with which the 82351 shares an IRQ must handle interrupt chaining 
properly. 

3 Perform driver workarounds. Here are some ways to work around 
drivers that are not behaving properly: 

• Upgrade the drivers for devices sharing an IRQ with the 82351, 
including but not limited to, your video drivers, your LAN drivers, 
Agilent IDE and/or SCSI drivers, and your sound drivers. 

• Try to force the Agilent driver to be installed earlier in the ISR 
chain. 

4 Reconfigure Your PC. Configure your PC so as to not share IRQ lines. 
Many PCIe cards have bugs when sharing IRQ lines. You may or may 
not be able to do this on your PC; many PCs can be configured using 
the setup option when the PC is first booting. 
Agilent 82351 PCIe GPIB Interface 33



2 Troubleshooting Guidelines
82351 Software Checks

This section provides guidelines for 82351 software checks, including:

✔ Check for 82351 Driver Files

✔ Disable Connection Expert Auto- Discovery

✔ Check BIOS/Interrupts Settings

✔ Set 82351 Read/Write Performance Mode

Check for 82351 Driver Files

After installing Agilent IO Libraries Suite, check for installed 82351 driver 
files.

1 Check for 82351 driver files. Files are listed in their default directories.

Table 2-1 Directories of the 82351 driver files

Windows 2000

Program Files C:\Program Files\Agilent\IO Libraries Suite\drivers\ag350i32.dll

Driver Files C:\Winnt\system32\drivers\agt82350.sys

.inf Files C:\Winnt\inf\agtgpib.inf

Windows XP

Program Files C:\Program Files\Agilent\IO Libraries Suite\drivers\ag350i32.dll

Driver Files C:\Windows\system32\drivers\agt82350.sys 

.inf Files C:\Windows\inf\agtgpib.inf 

NOTE If the “inf” folder is not found in C:\WINDOWS, on the WINDOWS folder, go to Tools > 
Folder Options > View. Scan the list of settings for Show hidden files and folders option 
and click to enable this setting. Click Apply then OK for the setting to take effect.
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2 Driver files not found. If any of the driver files cannot be found, 
re- install the 82351A driver from the 82351A Product Reference CD 
and repeat step 1. If problem persists, proceed to step 3.

3 Uninstall Agilent IO Libraries Suite. If the driver files cannot be 
found, uninstall the Agilent IO Libraries Suite. Go to Control Panel > 
Add or Remove Programs, select Agilent IO Libraries Suite and click 
Remove. Follow the instructions to remove the libraries. 

4 Re- install the Agilent IO Libraries Suite. Insert the 
Automation- Ready CD into CD- ROM, follow the instructions in 
Chapter 1, Step 2 – Installing Agilent IO Libraries Suite to re- install 
the libraries. If you do not have the Automation- Ready CD, you can 
download the Agilent IO Libraries Suite from 
www.agilent.com/find/iolib.

5 Re- install the 82351A driver. Re- install the 82351A driver from the 
accompanying 82351A Product Reference CD.

Disable Connection Expert Auto-Discovery

If your PC sound card stops working after configuring interfaces, disable 
the auto- discovery process in Connection Expert, as the auto- discovery 
process can cause sound and other cards to stop responding. 

To disable the auto- discovery process, run Connection Expert, select Tools 
> Options, and clear the check boxes labeled Automatic discovery or 
refresh of I/O resources and Automatic configuration of unconfigured 
interfaces. Close Connection Expert and restart your PC.
Agilent 82351 PCIe GPIB Interface 35

http://www.agilent.com/find/iolib
http://www.agilent.com/find/iolib


2 Troubleshooting Guidelines
Check BIOS/Interrupts Settings

If Connection Expert reports finding an 82351 card with Serial Number 
ffffffff, this is typically caused by PCIe cards not properly being 
configured. Try the following steps. If these steps do not work, remove 
and re- install the 82351 and then reconfigure the card.

1 Upgrade your system BIOS to the latest version. New computers often 
have newer BIOSs available. When installing new BIOS, ensure the BIOS 
Installed O/S setting is set correctly. This determines what software will 
configure all the Plug and Play cards in your system. Either the BIOS 
or the operating system can perform the task of querying all the cards 
to determine their resource needs, picking a valid configuration for all 
these cards, and telling the cards what their actual resource settings 
are.

2 If your computer locks up or freezes after installing. This is typically 
caused by interrupt conflicts with other drivers in the system. PCIe 
allows sharing of IRQs, but this also means the drivers for cards which 
share an IRQ must handle interrupt chaining properly. 

To validate the driver of 82351 card, right- click on My Computer and 
select Properties. Click the Device Manager in the Hardware tab, find 
the 82351 card and check that all other cards on the same IRQ have a 
valid driver, not the big yellow question mark.

When the IRQ is asserted, the OS calls each ISR in turn until one of 
them returns TRUE (meaning that it handled the interrupt). The ISR’s 
responsibility is to correctly return TRUE if its device was interrupting 
or FALSE if not. Drivers that return TRUE, even though they did not 
service the interrupt, will cause problems.

To perform driver workarounds, you can upgrade the drivers for devices 
sharing an IRQ with Agilent, including, but not limited to, your video 
drivers, your LAN drivers, Agilent IDE and/or SCSI drivers, and your 
sound drivers.
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3 Reconfigure Your PC. Configure your PC so as to not share IRQ lines. 
Many PCIe cards have bugs when sharing IRQ lines. You may or may 
not be able to do this on all PCs. Many PCs can be configured using the 
setup option when the PC is booting. 

Set 82351 Read/Write Performance Mode

The 82351 card read and write calls use one of two modes:

• Polling. Bytes are transferred to/from the card, one at a time. Polling 
mode is advantageous for transferring a small number of bytes because 
the setup overhead is very low, but it does require CPU involvement for 
each byte transferred.

• Interrupt. An entire buffer is transferred to/from the card without CPU 
involvement. Interrupt mode is advantageous for transferring large 
buffers because the higher per byte transfer rate more than 
compensates for the relatively long interrupt setup overhead.

The default behavior of the 82351 driver is to use Polling mode for 
transfers of 256 bytes or less and to use Interrupt mode for larger 
transfers. You can modify this default behavior by doing the following:

SICL: The SICL ihint(id, hint) function can be called to modify the 
read/write behavior for on a SICL session. The hint values allowed are:

• I_HINT_DONTCARE (default value) Use Interrupt mode for transfer 
requests larger than 256 bytes, otherwise, use Polling mode.

• I_HINT_USEPOLL Use the Polling mode.

• I_HINT_IO Use the Interrupt mode.

VISA: The VISA viSetAttribute(vi, VI_ATTR_DMA_ALLOW_EN, 
attrValue) function can be called to modify the read/write behavior for 
a VISA session. The VI_ATTR_DMA_ALLOW_EN values allowed are:

• VI_TRUE (default value) Use Interrupt mode for transfer requests larger 
than 256 bytes, otherwise, use Polling mode. 

• VI_FALSE Use the Polling mode. 
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Some additional factors to consider are:

• The settings discussed above are per session. This means you can open 
multiple sessions to a device and set different transfer modes for 
different sessions. The actual mode used will then depend on which 
session you are using for the read/write calls. 

• In both SICL (with hint = I_HINT_DONTCARE) and VISA (with 
VI_ATTR_DMA_ALLOW_EN = VI_TRUE), the size of the read request (as 
specified by buffer size in a SICL iread() or count in a VISA 
viRead() function call) will determine the mode used even if the 
number of bytes actually read is less. 

• The default formatted IO read buffer size is 4096 so when using this 
default size, formatted reads in SICL (with hint = I_HINT_DONTCARE) 
and VISA (with VI_ATTR_DMA_ALLOW_EN = VI_TRUE) will use 
Interrupt mode even when a small number of bytes are expected. 

• The default formatted IO write buffer size is 128 so when using this 
default size, formatted writes in SICL (with hint = 
I_HINT_DONTCARE) and VISA (with VI_ATTR_DMA_ALLOW_EN = 
VI_TRUE) will used Polling mode even when a large number of bytes 
are being sent. 

• In SICL, Polling mode will always be used for the iread(), ifread() 
and iscanf() regardless of the above settings, when a termchr is set 
(itermchr() is not set to - 1). 

• In VISA, Polling mode will always be used for viRead(), viBufRead() 
and viScanf() regardless of the above settings, when 
VI_ATTR_TERM_CHAR_EN = VI_TRUE. 

The crossover point at which the Interrupt mode becomes faster than the 
Polling mode depends on the CPU speed, with a faster CPU having a 
higher crossover point.
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Agilent IO Libraries Suite Checks

This section provides guidelines to troubleshoot problems involving the 
Agilent IO Libraries Suite, including:

✔ Check IO Libraries Suite Installation

✔ Check IO Control Operation

✔ Install IO Libraries Suite (if 82351 was Installed First)

Check IO Libraries Suite Installation

Start your Agilent IO Libraries Suite troubleshooting sequence by verifying 
IO Libraries Suite installation. If the IO Libraries Suite is installed, go to 
Check IO Control Operation.

1 Check the version of Agilent IO Libraries Suite. If a version of the 
Agilent IO Libraries has been installed, an IO icon is normally 
displayed on the Windows taskbar (on the lower right- hand side of the 
screen).

Figure 2-2 IO Libraries Suite icon

• If the IO icon is displayed, click the icon and click About Agilent IO 
Control to display the version. The version must be 14.2.8931.1 or 
greater. 

IO Libraries Suite icon

NOTE Agilent IO Libraries Suite 14.0 was the revision immediately following Agilent IO Libraries 
M.01.01, so you should consider revision “14.0” to be a greater version number than “L” or 
“M”. Configuration instructions in this manual make use of Agilent IO Libraries Suite 14.2.
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• If the IO icon is not displayed, a version may still be installed. To 
check this, click Start > Programs and look for the Agilent IO 
Libraries or Agilent IO Libraries Suite program group. 

• If this group is displayed, click Agilent IO Libraries Suite > Utilities 
> IO Control to display the IO icon. Then, click the icon and click 
About Agilent IO Control to display the installed version (must be 
14.2.8931.1 or greater). 

• If neither the IO icon nor the Agilent IO Libraries program group is 
displayed, no Agilent IO Libraries are installed. In this case, or if the 
installed version is not 14.2.8931.1 or greater, you must install the 
newer version (see Chapter 1, Step 2 – Installing Agilent IO Libraries 
Suite). 

2 Install Agilent IO Libraries Suite (as required). If version 14.2.8931.1 or 
greater of the Agilent IO Libraries is not installed on your PC, install 
the IO Libraries Suite. Otherwise, go to Check IO Control Operation.

Check IO Control Operation

When the Agilent IO Libraries Suite is installed, an IO Control is created. 
When the IO Control is active, it is displayed as an IO icon on the 
Windows taskbar. If the IO Control is deactivated, SICL/VISA applications 
that are running with the 82351 will be unable to open sessions. 

By default, the IO Control is always active after the Agilent IO Libraries 
Suite is installed and the IO icon is displayed. However, there may be 
times when IO Control can get deactivated and the IO icon is not 
displayed. There are two ways to hide the IO icon:

• Hide Agilent IO Control. Click the IO icon and select Hide Agilent 
IO Control from the drop down menu. Alternately, you can uncheck 
the View > Agilent IO Control in Connection Expert. This will hide 
the IO icon, but will not deactivate the IO Control.

• Click Exit. Click the IO icon and select Exit from the drop down 
menu. A dialog box explaining the consequences of removing the IO 
appears, click Yes to hide the IO icon and deactivate the IO Control.
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Troubleshooting Guidelines 2
If the IO icon is not displayed, either the IO icon display has been turned 
off and/or the IO Control (and associated iprocsvr.exe) is not active. In 
this case, click Start > Programs > Agilent IO Libraries Suite > Utilities 
> IO Control to re- start the IO Control and display the IO icon. 

Install IO Libraries Suite (if 82351 was installed first)

If you installed the 82351 before installing the Agilent IO Libraries Suite 
software, follow these steps to install and configure the IO Libraries Suite 
and the necessary drivers for your card. 

1 Install the Agilent IO Libraries Suite as described in Chapter 1, Step 2 
– Installing Agilent IO Libraries Suite.

2 If the Connection Expert utility does not recognize your 82351 and 
display it as a PCIe GPIB Interface, you may need to use Windows 
Device Manager to associate the correct drivers with your card. Follow 
the steps below:

a Start the Windows Device Manager as follows: Right- click on My 
Computer, select Properties, then the Hardware tab, then Device 
Manager.

b Find the PCI Simple Communications Controller in the Device 
Manager, and select Update Driver...

c Allow Windows to find and install the driver automatically. You are 
not require to insert a CD. 
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Environmental Conditions       46

This chapter describes product technical specifications that include general 
requirement, general characteristics and environmental specifications for 
Agilent 82351A PCIe GPIB interface card. 
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3 Specifications and Characteristics
General Requirements

Before installing Agilent 82351A PCIe GPIB interface card, ensure your PC 
meets the following requirements. Table 3- 1 shows the general 
requirements for installing Agilent 82351A PCIe GPIB interface card.

Table 3-1 General requirements

Software/Hardware Requirement

Minimum system requirements Windows 2000/XP

Software required Agilent IO Libraries Suite 14.2 and above

PCIe BUS slot 3.3 V PCIe, 32 bits

Support standards PCIe rev. 1.0a

IEEE 488.1 and IEEE 488.2 compatible
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General Characteristics

All characteristics are typical performance value and are not warranted. 
Table 3- 2 shows the general characteristics of Agilent 82351A PCIe GPIB 
interface card.

Table 3-2 General characteristics

General characteristics Requirement

Power Backplane +3.3 V PCIe

Connectors Standard 24-pin (IEEE-488)

+1.5 V PCIe

PCIe Slot PCIe 1x, PCIe 4x, PCIe 8x

GPIB transfer rate 1.4 MB/s or better

Maximum instrument connection 14 instruments – daisy chain via GPIB

Buffering Built-in

Configuration Plug and Play

Dimension (Width x Depth x Height) 158.3 mm (W) x 120.8 mm (D) x 21.6 mm (H) 

Weight 0.082 kg

Warranty 1 year

Safety and EMC IEC 61010-1:2001 / EN61010-1:2001

Canada: CSA C22.2 No. 61010-1:2004

IEC 61326:2002/EN61326:1997+A1:1998+A2:2001+A3:2003

Pollution Degree 2

This product is rated for indoor use only.
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3 Specifications and Characteristics
Environmental Conditions

This instrument is designed for indoor in the area with low condensation. 
Table 3- 3 shows the general environment specifications of Agilent 82351A 
PCIe GPIB interface card.

Table 3-3 Environmental conditions

Environmental Conditions Requirement

Operating environment – 5 °C to 60 °C

Operating humidity Up to 90% at 40 °C non-condensing

Storage environment – 40 °C to 70 °C

Storage humidity Up to 90% at 65 °C non-condensing
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Returning Instrument for Service       52

Contacting Agilent       53

This chapter provides general information for the Agilent 82351A PCIe 
GPIB Interface User’s Guide and guides you how to access the related 
documentation for 82351.
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4 General Information
Accessing an Electronic Copy of This Guide

There are two ways you can access an electronic (.pdf) version of this 
guide, as follows. You will need Adobe Acrobat Reader Version 3.0 or later 
to view the electronic version.

• Access from the IO Control. After the Agilent IO Libraries Suite is 
installed, an IO icon appears on the right hand side of the Windows 
toolbar. To access an electronic version of this guide, click the IO icon, 
then click Documentation and then click 82351 PCIe GPIB Users Guide.

• Access from the Web. On your Web browser address line, type 
www.agilent.com/find/82351A and navigate to the 82351 manual. The 
web version of the manual will always be the latest revision.
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Related Documentation

Suggested documentation you can use for 82351 operation follows. After 
the Agilent IO Libraries Suite has been installed on your PC, .pdf files of 
the Agilent IO Libraries Suite Getting Started Guide, VISA User’s Guide, 
and SICL User’s Guide are available. Click the IO icon on the Windows 
taskbar and then click Documentation.

Product Related Documentation

Agilent IO Libraries 
Suite

For additional information on the Agilent IO Libraries Suite, see the Agilent IO 
Libraries Suite Getting Started Guide and the Agilent IO Libraries Suite Online 
Help.

VISA To develop and use VISA applications, see the Agilent VISA User’s Guide and the 
VISA Online Help. 

VISA COM To develop and use VISA COM applications, see the VISA COM Online Help. 

SICL For SICL I/O applications, see the Agilent SICL User’s Guide for Windows and the 
SICL Online Help. 

Agilent T&M Toolkit To develop test and measurement programs in Visual Studio .NET quickly and 
easily, use the Agilent T&M Toolkit product (Web site at 
www.agilent.com/find/toolkit).
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4 General Information
Warranty Services

Standard Warranty (Worldwide)

1 Agilent warrants that this Agilent hardware, accessories, and/or 
supplies will be free from defects in materials and workmanship for the 
period specified above. If Agilent receives notice of such defects during 
the warranty period, Agilent will, at its option, either repair or replace 
products that prove to be defective. Replacement products may be 
either new or equivalent in performance to new.

2 Agilent warrants that Agilent software will not fail to execute its 
programming instructions for the period specified above, due to defects 
in material and workmanship when properly installed and used. If 
Agilent receives notices of such defects during the warranty period, 
Agilent will replace software that does not execute its programming 
instructions due to such defects.

3 Agilent does not warrant that the operation of Agilent products will be 
uninterrupted or error free. If Agilent is unable, within a reasonable 
time, to repair or replace any product to a condition as warranted, you 
will be entitled to a refund of the purchase price upon prompt return 
of the product.

4 Agilent products may contain remanufactured parts equivalent to new 
in performance or may have been subject to incidental use.

5 The warranty period begins on the date of delivery or on the date of 
installation if installed by Agilent. If customer schedules or delays 
Agilent installation more than 30 days after delivery, warranty begins 
on the 31st day after delivery.

6 This warranty does not apply to defects resulting from 

• improper or inadequate maintenance, repair, or calibration

• software, interfacing, parts, or supplies not supplied by Agilent

• unauthorized modification, or misuse

• operation outside of the published environmental specifications for 
the product

• improper site preparation or maintenance.
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7 Agilent makes no other express warranty, whether written or oral, with 
respect to this product.

8 TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE 
WARRANTIES ARE EXCLUSIVE AND NO OTHER WARRANTY OR 
CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR 
IMPLIED. AGILENT SPECIFICALLY DISCLAIMS ANY IMPLIED 
WARRANTIES OR CONDITIONS OF MERCHANT — ABILITY, 
SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR 
PURPOSE. Some countries, states, or provinces do not allow limitations 
on the duration of an implied warranty, so the above limitation or 
exclusion might not apply to you. This warranty gives you specific legal 
rights and you might also have other rights that vary from country to 
country, state to state, or province to province.

9 TO THE EXTENT ALLOWED BY LOCAL LAW, THE REMEDIES IN THIS 
WARRANTY STATEMENT ARE YOUR SOLE AND EXCLUSIVE 
REMEDIES EXCEPT TO THE EXTENT PROHIBITED BY LOCAL LAW, IN 
NO EVENT WILL AGILENT OR ITS SUBSIDIARIES, AFFILIATES OR 
SUPPLIERS BE LIABLE FOR DIRECT, SPECIAL, INCIDENTAL, 
CONSEQUENTIAL, OR OTHER DAMAGES (INCLUDING LOST PROFIT, 
LOST DATA, OR DOWNTIME COST), ARISING OUT OF THE USE, 
INABLITITY TO USE, OR THE RESULTS OF USE OF THE PRODUCT, 
WHETHER BASED IN WARRANTY, CONTRACT, TORT, OR OTHER 
LEGAL THEORY, AND WHETHER OR NOT ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES. Your use of product is entirely at 
your own risk. Some countries, states, and provinces do not allow the 
exclusion or limitation of liability for incidental or consequential 
damages, so the above limitation may not apply to you.

EXCEPT TO THE EXTENT ALLOWED BY LOCAL LAW, THESE 
WARRANTY TERMS, DO NOT EXCLUDE, RESTRICT OR MODIFY, AND 
ARE IN ADDITION TO, THE MANDATORY STATUTORY RIGHTS 
APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.

Accessories Warranty

Agilent offers warranty for product's accessories for up to 3 months from 
the end- user acceptance date. 
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4 General Information
Returning Instrument for Service 

Before shipping your instrument for repair or replacement, Agilent 
recommends that you acquire the shipping instructions from the Agilent 
Technologies Service Center. A clear understanding of the shipping 
instructions is necessary to secure your product for shipment. 

1 Write the following information on a tag and if attach to the 
instrument.

• Name and address of owner

• Instrument model number

• Instrument serial number

• Description of the service required or failure indications

2 Remove all accessories from the instrument

Do not include accessories unless they are associated with the failure 
symptoms.

3 Protect the instrument by wrapping it in plastic or heavy paper.

4 Pack the instrument in foam or other shock absorbing material and 
place it in a strong shipping container.

You are recommended to use the original shipping material or order 
materials from an Agilent Technologies Sales Office. If both options are 
not available, place 8 to 10 cm (3 to 4 inches) of shock- absorbing and 
static- free packaging material around the instrument to avoid movement 
during shipping. 

5 Seal the shipping container securely.

6 Mark the shipping container as FRAGILE.

In the ensuing correspondence, refer to the instrument by its model 
number and full serial number.

Agilent suggests that you always insure your shipments.
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Contacting Agilent

You can reach Agilent Technologies at this telephone number in the 
Americas:

Americas Call Center:      1- 800- 829- 4444

For other locations, contact your country’s Agilent support organization. 

A list of contact information for other countries is available on the Agilent 
Web site at: 

www.agilent.com/find/assist 

URL Description

www.agilent.com/find/assist Agilent Technologies “Contact Us” page

www.agilent.com/find/iolib Update the Agilent IO Libraries Suite software

www.agilent.com/find/ADN Connectivity resources all in one place

www.agilent.com/find/techsupport Technical support information, including manuals, 
application notes, FAQs, and software and firmware 
downloads

www.agilent.com/find/connectivity For connection, communication and control of test 
instruments from your computer, you can find out the 
latest in connectivity.
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